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Introducing Corel VideoStudio™ Pro X2 Ultimate

Corel VideoStudio™ Pro X2 Ultimate is the premier high-definition (HD) digital
media collection, providing everything users need to take their video editing to
the next level. VideoStudio Pro X2 Ultimate includes:

e the full video editing power of Corel VideoStudio™ Pro X2

e the world’s leading DVD and Blu-ray playback software
Corel® WinDVD® 9 Plus Blu-ray

e and disc copy and conversion tools with Corel® DVD Copy™ 6 Plus.

e audio mastering with Steinberg® WaveLab™ LE 6

With VideoStudio Pro X2, users can import video from HDV (High-Definition
Video), AVCHD™ (Advanced Video Codec High Definition), Blu-ray Disc®, and
JVC® HD camcorders to take advantage of free-form creative tools and a wealth
of professionally designed templates. Steinberg® WavelLab™ LE 6 and full support
for Dolby® Digital 5.1 make it easy for users to create stunning professional
soundtracks for their slide shows and videos. Users can also share their
productions with family and friends on Blu-ray Disc, AVCHD disc, standard DVDs,
or by uploading directly to YouTube™.

The Ultimate Solution for HD Video Production

With everything users need to take their HD editing to the next level,
VideoStudio Pro X2 provides fast and smooth editing, quick encoding, and
flexible output options. Users can capture and edit video in all the leading HD
formats, including HDV, AVCHD, Blu-ray Disc (BDMV), and JVC® HD camcorder
(TOD).

With its Smart Proxy editing and support for both dual-core and quad-core CPUs,
VideoStudio lets even midrange PCs edit HD content efficiently. The new
MainConcept H.264 codec provides rapid encoding with superior quality, and
the MPEG Optimizer suggests the fastest, best-quality encoding settings. In
addition, WinDVD® 9 Plus Blu-ray lets users playback their Blu-ray and AVCHD
productions at home or on the road.
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Professional, Easy-To-Use Editing Tools

VideoStudio Pro X2 provides an array of professional, easy-to-use editing tools
that help users create compelling, Hollywood-style video projects. The new,
sophisticated graphite user interface provides enlarged controls for filters and
effects, one-click previews, scalable Library thumbnails, and an instant timecode
tip. Users can easily create sophisticated picture-in-picture and montage effects,
automatic audio and video crossfades, title animations, color backgrounds, and
much more.

With support for Dolby Digital 5.1 surround-sound audio, users can create videos
that take full advantage of today’s home theater systems. What's more, the
powerful mastering application Steinberg WavelLab LE 6 lets users edit audio
and improve sound quality.

Unique Special Effects

Users can explore their creativity and personalize their video projects with a
collection of special effects and easy-to-use templates. The new Painting Creator
is an unrivaled feature that lets users paint, draw, or write on their videos. Users
can also give their video an “old-film"” appearance by using one of the filters
from NewBlue® Film Effects.

With the Chroma Key effect, users can superimpose any background onto a
video — just like the pros do. In addition, many professionally designed HD-style
templates, menu templates and transitions, overlay objects, frames, and Flash
animations are included.

Any Output, Anywhere

With Corel VideoStudio Pro X2 Ultimate, users can easily share their videos with
family and friends or seek a much broader audience. They can author Blu-ray
Discs with advanced menus, burn HD video on a standard DVD in AVCHD format,
create DVDs with professional menus, output video to mobile devices, and even
upload directly to YouTube. With support for Apple® iPhone™ and FLV (Flash
Video) users can easily watch their videos on the go. In addition, Corel® DVD
Copy™ 6 Plus lets users copy and convert any disc or video, and even convert
video for mobile devices.
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VideoStudio Pro xz



- o Ultimate’
VideoStudio Pro x2

Customer Profiles

Specialist: Technology Enthusiasts

Technology enthusiasts are early adopters of new technology who enjoy
capturing video during family, school, social, club, or sports events. They have
invested in an HD camcorder, HDTV, set-top Blu-ray DVD player, and HD burner
for their computer. They seek professional tools that let them pursue advanced
video-editing projects and take advantage of their technology investment by
working with the latest HD video, audio, and disc formats.

Intermediate: Hobbyists

Hobbyists shoot lots of videos and photos, particularly during significant social
events. They seek easy-to-use tools that let them express their creativity by
personalizing their videos and photos with unique features and effects. They
enjoy the immediacy of sharing their projects on mobile devices or the Web.
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What's Included?

: Main Application

e Corel VideoStudio™ Pro X2 Ultimate: This all-in-one video-editing and
disc-authoring application makes it easy to create professional-looking
videos, slide shows, and DVDs.

e

¢ VideoStudio Editor — for powerful editing and disc authoring tools

X Oid4 OIPNISOSPIA g y |

¢ Movie Wizard - to make complete movies in a few clicks

¢ DV-to-DVD Wizard - the fastest way to record directly from tape to disc

: Extra Applications
-
, % 1 e Corel® WinDVD® 9 Plus Blu-ray: The world’s #1 DVD and Blu-ray playback

WinDVD'9 L software.

In

e e Corel® DVD Copy™ 6 Plus: Disc and video copying and converting software,
with support for converting for mobile devices.

e Steinberg® WavelLab™ LE 6: A fast, streamlined audio editor and mastering
application.

Supplementary Content

e An extensive library of templates, overlay clips, title animations, menus, and
DVDCQPFGF-@ effects are included to help users personalize their projects.

o

3 WAVELAB LE

Bonus Effects

NewBlue?® Film Effects: Five filters with 81 presets that give videos the
magic of an “old-film"” appearance.

Documentation
e Help file
e PDF user guide

VideoStudio Pro x2 Reviewer’s Guide [ 5 ]



System Requirements

Minimum requirements for VideoStudio™ Pro X2,
WinDVD® 9 Plus Blu-ray, and DVD Copy™ 6 Plus:

¢ Intel® Pentium® 4, AMD Athlon™ XP (or equivalent), or higher recommended

e  Microsoft® Windows® XP SP2 Home Edition/Professional, Windows® XP
Media Center Edition, Windows® XP Professional x64 Edition, or
Windows Vista® operating system software

e 512 MB of RAM (1 GB of RAM or more recommended)
¢ 1 GB of hard disk space (for installation)

e Windows-compatible sound card (multi-channel sound card recommended
for surround sound support)

e Windows-compatible DVD drive (for installation)

For non-proxy HDV editing:

* 3.0 GHz Intel Pentium 4 processor, AMD Althon™ XP 3000+ or higher with
Hyper-Threading technology

e 1 GB of RAM (2 GB or more recommended)

For Blu-ray Disc® and HD DVD playback:

¢  Minimum CPU - Intel® Core™ Duo T2400 1.83 GHz; AMD Athlon 64 X2
3800+ 2.0 GHz

¢ Recommended CPU - Intel® Core™ Duo T2500 2.0 GHz, Core™2 Duo E6400
2.13 GHz, Core™2 Quad Q6600 2.40 GHz, Core™2 Duo T5500 1.66 GHz, or
higher; AMD Athlon™ 64 FX-60 2.6 GHz, AMD Athlon™ 64 X2 4200+ 2.2 GHz,
AMD Turion™ 64 X2 TL-60 2.0 GHz, or higher

* VGA chipset - 128 MB VGA VRAM or higher (256 MB recommended) with
support for hardware acceleration

¢ Minimum graphic card — NVIDIA® GeForce® 7600, ATI Radeon™ X1600

¢ Recommended graphic card — NVIDIA® GeForce® 8400, ATI Radeon™ HD
2400 or higher

¢ VGA driver version - To ensure that you can enjoy full quality of Blu-ray
and HD DVD movies, please visit the NVIDIA® or ATl websites to download
the latest drivers.

e Optical drive - A Blu-ray optical drive is required for Blu-ray Disc® playback,
a HD DVD drive is required for HD DVD playback. Both Blu-ray and HD DVD
drives support playback of standard DVDs. Standard DVD optical drives
support playback of HD DVD videos on standard DVDs, as well as AVCHD™
discs.

¢ Display device - If you are using a DVI (Digital Visual Interface) or HDMI
(High-Definition Multimedia Interface) connection to a digital output,
please make sure that your display device is HDCP (High-bandwidth Digital
Content Protection) compatible and that your VGA supports HDCP.

Input/Output Device Support

e |IEEE 1394 FireWire cards for use with DV/D8/HDV camcorders
e Support for OHCl-compliant IEEE-1394

¢ Analog capture cards for analog camcorders

e Analog and digital TV capture device

u % Ultimate'
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USB capture devices, PC cameras, as well as DVD, hard drive, Blu-ray, and
AVCHD camcorders

Windows-compatible Blu-ray, DVD-R/RW, DVD+R/RW, DVD-RAM, or
CD-R/RW drive

Apple® iPhone™, Apple® iPod® with video, Sony PlayStation® Portable (PSP),
Pocket PC, Smartphone, Nokia® mobile phone, Microsoft® Zune®

Input File Format Support

VideoStudio™ Pro X2

Video: AVI, MPEG-1, MPEG-2, HDV, AVCHD, M2T, MPEG-4, H.264,
QuickTime®, Windows Media® Format, DVR-MS, MOD (JVC® MOD file
format), M2TS, TOD, BDMV, 3GPP, 3GPP2

Audio: Dolby® Digital Stereo, Dolby® Digital 5.1, MP3, MPA, WAV, Windows
Media Format

Image: BMP, CLP, CUR, EPS, FAX, FPX, GIF87a, ICO, IFF, IMG, JP2, JPC, JPG, PCD,
PCT, PCX, PIC, PNG, PSD, PXR, RAS, SCT, SHG, TGA, TIF/TIFF, UFO, UFP, WMF
Disc: DVD, Video CD (VCD), Super Video CD (SVCD)

WinDVD® 9 Plus Blu-ray

Disc: DVD-Video, VCD, SVCD, Mini DVD (DVD on CD), WMV HD, Audio CD,
AVCHD, HD DVD, Blu-ray Disc, HD DVD-R, BD-R, and RE

Video: MPEG-1, 2, 3GPP/3GPP2, DivX®, Windows Media, AVI, RealPlayer®,
QuickTime® formats, HDV, MPEG-2 HD, AVCHD

Blu-ray Disc® / HD DVD Video: MPEG2, VC1, H.264
Audio: Dolby Digital, MP3, AAC, MPA, M2A, WAV, WMA, DTS®, LPCM.

Blu-ray Disc® / HD DVD Audio: LPCM, Dolby Digital, Dolby Digital® Plus,
Dolby® TrueHD, DTS, DTS-HD®

DVD Copy™ 6 Plus

Video: AVI, MPG, M2V, MPEG-1, MPEG-2, MPEG-4, H.264, QuickTime, MOV,
ASF, WMV, DVR-MS, 3GPP, 3GPP2, DivX, Xvid, TiVo®

Disc: DVD (DVD-Video, DVD+VR, DVD-VR), Video CD (VCD), Super Video CD
(SvCD), AVCHD

Output File Format Support

VideoStudio™ Pro X2

Video: AVI, MPEG-1, MPEG-2, HDV, AVCHD, MPEG-4, H.264, QuickTime,
RealMedia, Windows Media Format, BDMV, 3GPP, 3GPP2, FLV

Audio: Dolby Digital Stereo, Dolby Digital 5.1, MPA, WAV, Windows Media
Format

Image: BMP, JPG
Disc: DVD, Video CD (VCD), Super Video CD (SVCD), Blu-ray (BDMV)

Media: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R Dual Layer, DVD+R Double
Layer, BD-R/RE
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DVD Copy™ 6 Plus

Video: MPEG-1, MPEG-2, MPEG-4, H.264, WMV, DivX, DivX® mobile and
gmobile

Audio: WMA, WAV

Disc: DVD (DVD-Video, DVD+VR, DVD-VR), Video CD (VCD), Super Video CD

(SvCD)
Mobile Device: iPod, iPhone, PSP, Zune, cell phone

Steinberg® WavelLab™ LE 6

Required:

Intel Pentium, AMD Athlon 800 MHz

256 MB of RAM

80 MB of hard disk space

Windows 2000, Windows XP, Windows Vista (32-bit only)

Graphic card with 24-bit or 32-bit resolution

Display resolution 1024 x 768 pixels

Windows MME compatible audio hardware

CD or DVD drive

Internet connection (for product activation, podcast, and future updates)
Product can only be used on system on which it was activated

Recommended:

Intel Pentium 1V, AMD Athlon, or AMD Opteron™ 2.4 GHz or faster
1 GB of RAM

Graphics card with 32 bit resolution

ASIO compatible audio hardware

DVD writer

Display resolution 1280 x 1024 pixels, dual monitor setup

Internet connection (for podcast and future updates)

Reviewer’s Guide [ 8]
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The Ultimate Solution for HD Video Production

Corel VideoStudio™ Pro X2 Ultimate is everything users need to take their HD
editing to the next level. Whether the source is tape, disc, camcorder, or memory
card, users can capture and edit video in all the leading HD formats, including
HDV, AVCHD, Blu-ray Disc, and TOD.

Fast, Smooth Video Capture and Editing

With an updated user interface, the ability to import from multiple camcorders
and storage devices, and the unique Smart Proxy editing feature, VideoStudio
helps users edit video quickly and smoothly.

Enhanced! Smart Proxy editing: With Smart Proxy editing, users can edit
HD content as easily as they edit SD (standard definition) — even on midrange
PCs. By using lower-resolution files for editing and previewing an HD project,
VideoStudio Pro X2 requires fewer system resources, which results in faster,
smoother editing of HD video. The final output retains the full resolution of the
original HD content.

New! BDMV import: Users can now import BDMV files directly from Blu-ray
camcorders, making it easier to transfer files and get started with video-editing
projects.

AVCHD™ import: VideoStudio lets users import AVCHD files directly from
AVCHD hard drives, memory card camcorders, or any storage medium.

Fast Encoding

Though easy-to-use, VideoStudio Pro X2 is a powerful video-editing application.
The unrivaled MPEG Optimizer, the MainConcept H.264 codec, and support for

both dual-core and quad-core CPUs mean users spend less time waiting to view
their discs and DVDs.

H.264 High Definition (HD) encoding: VideoStudio Pro X2 uses the new

MainConcept H.264 codec, which provides rapid encoding with superior quality.
Both 1440 x 1080 and 1920 x 1080 output frame sizes are supported.

Reviewer’s Guide [ 9 ]



TOD format support: Users can import and edit video from the latest

JVC HD-7 camcorders without having to convert formats. VideoStudio fully
supports all frame sizes offered by these camcorders, including Full HD 1920 x
1080i. Users can expect efficient performance with the MPEG Optimizer and the
SmartRender feature, both of which support TOD video.

Choice of Output

VideoStudio Pro X2 lets users create Blu-ray Discs, burn HD video on standard
DVDs in AVCHD format, create DVDs with stylish, professional-looking menus,
and output video projects to mobile devices or online sharing Web

sites — such as YouTube.

Blu-ray Disc® output: Users can author HD video with motion menus and
burn the video to Blu-ray Disc (single- or dual-layer). Compliant video is not
re-rendered, ensuring shorter encoding times and excellent picture quality.
VideoStudio Pro X2 also supports Dolby® stereo (two-channel) and 5.1 audio.

[
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Users can create sophisticated Blu-ray Disc menus.
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AVCHD™ output: With AVCHD support, VideoStudio Pro X2 users can author
HD video with menus and burn to a standard DVD. AVCHD discs are playable on
PC (with AVCHD playback software), Blu-ray player, Sony PlayStation®3 (PS3), or
disc-based AVCHD camcorder.

9, Create Disc

Blu-ray

© =

Users can choose from several output formats.

To create an AVCHD disc

1 In VideoStudio, open and edit a high-definition (HD) or standard-
definition (SD) video.

2 Click Share, click E Create Disc, and choose AVCHD from the drop-
down list.

In the Corel VideoStudio menu-authoring module, click Next.

4 Choose a menu template from the Gallery, click the title area in the
preview window to rename, move, or resize titles and buttons.

5 Click Next, and then click Burn [.

Create WMV-HD and MPEG-2 HD files: Users can create WMV-HD and
MPEG-2 HD files for playback on Media Center PCs or other HD playback devices.

Write back to HDV camcorder: With VideoStudio, users can record finished
video projects back to tape. This is convenient for viewing directly from a
camcorder or for long-term archiving.

Switch between HD and SD output: Users can choose to output an HD
project in standard definition (SD), and vice versa. On the Timeline, users can
seamlessly mix HD and SD formats.

Movie playback: With the full version of Corel® WinDVD® 9 Plus Blu-ray, users
can playback both Blu-ray and AVCHD discs on their computer. The world’s
leading DVD and video playback software lets users enjoy standard DVDs with
state-of-the-art HD upscaling. In addition, advanced battery optimization
controls for laptops makes it easier than ever to take movies on the go.
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TRIMENSIO

With Corel WinDVD 9 Plus Blu-ray and Trimension AlI2HD, users
can enjoy HD upscaling of standard DVDs

To watch a standard DVD in HD quality

1
2
3
4

Start Corel WinDVD 9 Plus Blu-ray.
Insert a DVD in your DVD drive, and click Play.
Click Video, and choose AlI2HD from the menu.

In the Enhance Video dialog box, click the Enable Trimension
AIlI2HD check box.

In the Digital Natural Motion area, choose Best Quality from the
list box.

Click the Close B button.

Reviewer’s Guide [ 12 ]
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Key Features

Corel VideoStudio™ Pro X2 Ultimate is an all-in-one video-editing and disc-
authoring application that makes it easy to create professional-looking videos,
slide shows, and DVDs.

Professional, Easy-To-Use Editing Tools

VideoStudio includes a wealth of professional-quality, yet easy-to-use editing
tools that help users polish their video productions. Users can choose from three
easy ways to make a movie:

VideoStudio Editor — for complete control and power

Movie Wizard - for users who are new to video editing

DV-to-DVD Wizard™ - for the shortest way from camcorder tape to disc
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Users can take control with a full set of editing tools.
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New! Transitions in overlay tracks: Superimposed over a video, overlay
tracks can be additional video, still images, or color clips. Users can easily apply
transitions in overlay tracks to create sophisticated picture-in-picture and

Taks Me These| Once again

With transitions in overlay tracks, users can create sophisticated picture-in-picture effects.

To apply a transition

1 In VideoStudio, click Effect, and choose one of the options from the
Galleryﬂ drop-down list.
2 Preview a transition by double-clicking a thumbnail.

3 Apply a transition by dragging it between two clips in the Timeline.

New! Auto-video/audio crossfade: Users can now simply drag video clips
so that the clips overlap on the timeline, automatically creating a video
transition and audio crossfade for the duration of the overlap.

New! Resizable interface: VideoStudio now lets users resize any of the
panels within the interface according to their preference.

New! Enlarged filter and effects controls: For VideoStudio Pro X2,
dialog boxes and controls have been enlarged, so that users can apply effects
and keyframes more quickly, easily, and accurately.

New! Toggle Filter View: With a single click, users can now preview the
effects of filters on their videos. A toggle icon appears next to each filter, so
users can instantly turn the effect on or off.

New! Autoplay of transitions and filters: Users can simply click any

transition, filter, or title animation to display a preview of the effect before
applying it to a video.

Reviewer’s Guide [ 14 ]
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New! Show all tracks: It's never been easier to get a quick glimpse of all
tracks in a video. With a single click, users can switch the Timeline View to show
only the portion being worked on or a comprehensive display of all elements in
a movie project.

Enhanced! Storyboard View: With VideoStudio Pro X2, users can simply
drag to adjust the size of the Storyboard to suit their preference. The Storyboard
View also lets users drag to add clips to a movie. In addition, users can apply
filters directly to the clips in the Storyboard.

New! Instant timecode tip: When users drag clips into the timeline,
VideoStudio now provides an instant timecode tip. This tip displays the change
in video duration in real time, making it easier for users to trim clips accurately.

New! Auto Pan & Zoom in VideoStudio Editor: Auto Pan & Zoom is now
available in both the Movie Wizard and VideoStudio Editor. When making photo
slide shows, it automatically detects the faces of subjects in the photo and
homes in on them. This eliminates the tedious manual work of applying Pan &
Zoom effects.

New! Single Clip Trim: The new Single Clip Trim dialog box makes it easy to
frame and accurately trim single clips. Users can access the dialog box by double-
clicking any clip in the Library.

Users can easily trim single clips.

To trim a single clip

1 In VideoStudio, double-click any clip in the Library.
2 In the Single Clip Trim dialog box, use the Jog Wheel to select a
starting point, and click the Mark-in @ button (or press F2).

3 Use the Jog Wheel to select an endpoint, and click the Mark-out E
button (or press F3).

4 To preview the result, click Play © (or press Spacebar).
When you are satisfied with the result, click OK.
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New! Updated icons: Many features, such as Smart Proxy and Ripple Editing,
are now easier to find, thanks to updated, intuitive icons.

Instant preview: By double-clicking the preview window, users can access an
instant, full-screen preview of their video project.

Audio View: In the Audio View, users can visually adjust volume levels of the
individual video, voice, and music clips that make up a project’s soundtrack. For
example, by using the wave form in Audio View, users can easily cue a title on a
particular beat. In addition, Audio View provides access to the Surround Sound
Mixer, Overlay Track, and the Music Track.

= Toke Me There Once again It's Cool- Cool
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Users can easily adjust volume levels in the Audio View.

Multi-trim Video: With the Multi-trim feature, users can easily extract
multiple segments from video clips. The AccuCut timeline makes it fast and
simple to zoom in precisely on the exact frame that needs to be trimmed. In
addition, Ad-Zapper automatically detects commercials in videos captured from
TV, allowing for easy removal. What's more, the Jog Wheel lets users quickly
scroll through a clip, and the Shuttle Slider makes it easy to find an exact frame.

Automatic color and tone correction: VideoStudio Pro X2 automatically
corrects the color and tone of videos that have been taken under less than ideal
lighting conditions.

Corel VideoStudio Pro X2 automatically corrects video color and tone.

DeBlock filter: The DeBlock filter reduces blocky digital-compression artifacts
often found in highly compressed videos. This filter is particularly useful for
videos copied from Video CDs (VCD) or other low-resolution formats.

Reviewer’s Guide [ 16 ]
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DeSnow filter: The DeSnow filter removes visible noise patterns (colored spots
or snow) that occur in videos taken under low lighting conditions, taken with
high 1SO values, or captured from older sources — for example, videos copied
from VHS tapes.

New! Two title tracks: With an additional title track available, users can
include a title that runs through the entire video and easily add more titles.

New! Title animations: VideoStudio includes ten new animation presets to
use with titles, including a traditional favorite — Perspective Scroll. Animated
titles give viewers additional information about a video, or introduce or
differentiate a particular portion of the video.

& Apply animation

Type Paowe |+ [} Pop-up Animation

ABCD | AB(C ABCD AB
EF GH EF E
ABCD

EF

Users can easily add title animations.

To apply a title animation

1 In VideoStudio, click Title, and double-click one of the title animation
thumbnails.

2 Edit the title text by double-clicking the text in the preview window
and typing a new title.

3 Edit the text attributes by adjusting any of the settings on the Edit
tab.

Enhanced! Color backgrounds for titles: To add more personal flair to
their videos, users can choose from a variety of colored background shapes and
styles that make their movie titles stand out.

Users can easily add colored backgrounds to titles.

. "Uiimate’
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Dolby® Digital 5.1 surround sound: With comprehensive support for
Dolby® Digital 5.1 surround sound, users can produce videos that take full
advantage of today’s home theater systems. VideoStudio provides one-click
conversion that automatically turns conventional stereo audio into Dolby Digital
5.1 surround sound. For a more hands-on approach, the Surround Sound Mixer
offers complete control over stereo and panning for audio tracks. In addition,
users can simply blend camcorder audio and background music to produce a
compelling surround-sound effect.

Surround m

The Surround Mixer lets users create stunning audio effects.

To use the Surround Sound Mixer

1 In VideoStudio, open a camcorder video that includes dialogue.

2 Add a background music clip by clicking the Audio View | ¢ icon
and then dragging an audio clip onto the Music Track.

3 Ensure that the Music Track is selected, click the 5.1 Surround M
icon, and then click the Surround Sound Mixer tab.

4 Drag the Center channel level to 0.

Drag to reduce the Volume level by 6 or 12 db.

6 Click Play [ ] to preview the surround-sound effect.

SmartSound® Auto Music Maker: This advanced music engine lets users
create an infinite variety of unique royalty-free tunes that perfectly fit the style
and duration of their video project.

Audio filters: VideoStudio includes a collection of audio filters to help users fix
common audio problems and enhance the sound of their video projects. Users
can choose from Amplify, Hiss Reduction, Long Echo, Normalize, Pitch Shift,
Remove Noise, Reverb, Stadium, Vocal Reduction, and Volume Leveling.

Library organization: The Library makes it easy for users to sort media clips
by date, time, or filename. Media clips can include video clips, video filters,
audio clips, still images, transition effects, music files, titles, and color clips —
everything needed to create a movie.
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New! Import/Export library file: With VideoStudio Pro X2, users can now
save their presets and settings before reinstalling or upgrading their application.
This feature eases the transition to the latest version.

New! Add Projects library: With the new option to add a Projects library,
VideoStudio makes it easier to reuse and modify files from existing projects.
Users can add projects (VSP files) directly into the Timeline as a virtual clip,
saving time by eliminating the need to re-encode or re-render previously used
project files. These project files can then be organized into their own folder.

New! Specify capture library: VideoStudio Pro X2 users can eliminate
clutter by setting up a dedicated target library for each project, making it easier
to organize and find specific files.

New! Integration with Windows Vista® Media library: Users can now
load media directly from the Windows Vista® Media library. This features makes
it easier to access other media files to use in video projects.

New! Adjustable thumbnails: By dragging a convenient slider, users can
now adjust the size of thumbnails in the Library. By enlarging thumbnails, users
can zoom in to identify a particular clip. By reducing the size of thumbnails,
users can zoom out for an overall view of all available clips.

New! Categorized filter effects: For VideoStudio Pro X2, the filter effects
have been reorganized into categories that make them easier to identify and
navigate. The new categories are 2D Mapping, 3D Texture Mapping, Adjust,
Camera Lens, Darkroom, Focus, Nature Painting, and Special.

Enhanced! Movie Wizard templates: The Movie Wizard is the perfect
starting place for first-time video editors to quickly produce exciting, Hollywood-
style movies. Each template provides a different theme, which comes with preset
start and ending video clips, transitions, titles, and background music.

[ Corel Vidsastudio Movie Wizard - Untitied =

The Movie Wizard helps users produce exciting, Hollywood-style movies.
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To use the Movie Wizard

1 Start Corel VideoStudio Pro X2, and click Movie Wizard in the
Launcher.

2 Drag avideo clip into the Media Clip List at the bottom of the Movie
Wizard, and click Next.
Note: You can also use photos to create a slide show.

3 Choose Home Movie from the Theme Template drop-down list, and
select a template.

4 Click the Text Properties %} icon, adjust the settings that you want to
change, and click OK.

5 To edit the title of your movie, double-click the title in the preview
window, and type the title that you want to use.

6 Click the Load Background Music icon, click Add Audio in the
Audio Options dialog box, and choose the audio file that you want
to use.

7 Click Open, click OK, and then click Next in the Movie Wizard.

8 Click the Create Video File @ icon and choose NTSC DVD (4:3
Dolby Digital 5.1) from the drop-down list.

9 Inthe Create Video File dialog box, choose a location for your movie,
type a name in the File name box, and click Save.

Enhanced! Fit slides to music tempo and duration: With VideoStudio
Pro X2, it's easier than ever for users to adjust the slide duration to match the
tempo of background music. Users can also adjust the music duration to match
the duration of slides in a project.

Enhanced! Smart Pan & Zoom: The enhanced Smart Pan & Zoom feature
automatically detects the faces of subjects in a photo and homes in on them.
Users can create dynamic, motion-rich slide shows without the tedious manual
work of applying panning and zooming effects.

Create DVDs faster than ever: The DV-to-DVD Wizard lets users transfer an
entire DV tape to DVD (with a menu) in one step. In addition, the “blank”
template option lets users back up DV tapes or archive footage for the fastest,
most straightforward way to transfer from tape to disc.

DV Quick Scan: For archiving DV tapes, VideoStudio scans the tape and
generates a thumbnail list of clips. Users can select and capture the clips they
want, and then print out scene digests as a record of the content.

New! Steinberg® WavelLab™ LE 6: Users can edit audio and improve sound
quality with this powerful mastering software. In addition to support for VST
plugins, WavelLab LE 6 includes professional filters and enhancement tools, such
as EQ, Normalize, and Noise Gate.
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With Steinberg Wavelab LE 6, users can edit audio and improve sound quality..

To create a voiceover in VideoStudio

1 InVideoStudio, open a video to which you want to add a voiceover.
Ensure that your microphone is plugged in.

2 Click Audio, click Record Voice, and click Start in the Adjust
Volume dialog box..

When you are finished recording your voiceover, click Stop.

4 Save your project.

VideoStudio will automatically save your voiceover and assign it a file
name according to the date created. For example, uvs080709-001.

To add reverb to the voiceover in WavelLab

1 Start Wavelab, and click File » Open » Wave.

2 Inthe Open dialog box, navigate to C:\Documents and
Settings\Yourname\My Documents\Corel VideoStudio\12.0,
select the WAV that you recorded, and click Open.

Click Edit » Select » All.

4 In the Effects section, click 1 and choose Reverb from the drop-menu.
Press Play to hear the effect.

5 Click File » Save As.

6 In the Save dialog box, navigate to C:\Documents and
Settings\Yourname\My Documents\Corel VideoStudio\12.0, and
click Save.

To output the project from VideoStudio

1 In VideoStudio, click Play to make sure the voiceover is in sync.

2 Click Share, and choose the output for your project.
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Unique Special Effects

VideoStudio Pro X2 lets users explore their creativity with unique special effects,
tools, and easy-to-use templates.

New! Painting Creator: This unique new tool gives users another way to
personalize their video projects. With the Painting Creator, users can record
painting, drawing, or writing strokes as an animation to use as an overlay effect.
For example, users can enhance a family vacation video by drawing their route
on a map and overlaying it on the video. The Painting Creator lets users choose
to create still paintings or animations.

[

Painting Creator | Animation mode, 840 x 480 ) =)

Users can draw or paint directly on a video.

To create an animation with the Painting Creator

1 In VideoStudio, click the Painting Creator icon.

2 In the Painting Creator, choose a brush type, brush width and
height, and color.

3 Click © Start Recording, and draw on the preview window.
4 Click ™ Stop Recording.

5 Click Play to preview your animation.
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6 When you are satisfied with the result, click OK.
The Painting Creator will save your animation as an overlay clip
without background image and store it in the Video gallery.
(To include the background image with the animation, click the

Preference setting |i§] icon, enable the Set reference image as
background image option in the Preferences dialog box, and then
click OK.)

7 To use your painting in a video, drag the thumbnail from the Video
gallery onto the Overlay Track in the Timeline.

New! NewBlue® Film Effects: Users can now make videos look like they are
from the silent-movie era. This dynamic collection of five filters provides 81
presets that recreate the inexact mechanics of hand-cranked cameras, dirty
projectors, and decades of sitting in film vaults.

Users can apply effects that make their videos look like they are from the silent-movie era.

Chroma Key: Commonly referred to as Bluescreen, the Chroma Key special
effect lets users create video magic just like the pros. By making a particular
color transparent, the underlying clips, objects, or layers can be superimposed
onto any background. For example, users can film a subject against a solid
background and later add any background image, which makes the subject
appear to be in a particular location.

Adjustable playback speed: Users can create slow and fast motion effects,
without altering the pitch of the audio.

New! HD-style templates: With VideoStudio Pro X2, a new set of
professionally designed templates are included. These HD-style templates are
designed to match the quality of any HD video.

New! Creative content: VideoStudio Pro X2 includes a wealth of content to
enhance any production. Users can choose from many overlay objects, frames,

Flash animations, and menu templates.

Easy-to-use menu templates: Users can polish their productions with more
than 100 motion menus in a range of styles for any occasion.
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Menu transitions: Users can easily add transitions just like those in Hollywood
DVDs. VideoStudio includes a collection of menu-in and menu-out transitions
that smoothly flow from one menu into the next title or menu.

Any Output, Anywhere

VideoStudio Pro X2 gives users a multitude of options for sharing their videos
with the world.

Direct YouTube™ upload: Users can easily upload their videos directly to
YouTube — the most popular online video-sharing Web site. VideoStudio offers
several settings, such as the WMV, H.264, and FLV formats, to ensure the best
possible encoding quality.

To upload a video to YouTube

1 In VideoStudio, click the Share panel, then click @i Share Video
Online, and choose Browse for a File to Upload from the drop-
down list.

2 Inthe Open Video File dialog box, select a file to upload, and click
Open.

3 If you're already a YouTube member, type your Username and
Password, and click Next.

If you're new to YouTube, click the Join YouTube button, and
complete the form to create an account.

Quality movies for mobile devices: VideoStudio Pro X2 includes MPEG-4,
H.264, and WMV templates that let users produce movies for mobile devices,
such as Apple iPod, Touch, and iPhone, as well as Sony PSP, Zune, and Nokia
mobile phones. In addition, VideoStudio lets users import video from supported
cell phones, smartphones, PDAs, and other portable devices.

DivX support: Users can easily import and export DivX-encoded video with the
appropriate codec and convert the video to DVD or other formats.

Output to any disc: By providing many disc output options, VideoStudio
ensures that users can easily share their video productions. Users can burn their
videos to CDs and DVDs as well as to AVCHD and Blu-ray formats.

New! Intel® quad-core support: VideoStudio Pro X2 supports Intel® quad-
core technology, enhanced for both dual-core and quad-core CPUs to provide
faster response times and less time waiting for encoding — especially useful
when working with HD video.

New! Faster rendering: While rendering a video production, users can now

disable the preview window to maximize rendering resources and render the
video more quickly.
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New! Faster MPEG-2 encoding: VideoStudio Pro X2 provides enhanced
encoding performance for MPEG-2 files.

MPEG Optimizer: VideoStudio ensures the fastest encoding at the highest
possible quality. The MPEG Optimizer analyzes the bit rates of all clips on the
Timeline and suggests MPEG encoding settings that ensure the least
re-rendering and re-encoding while maintaining the highest quality for a video

project.
| MPEG Optimizer @
(2} Optimal project settings profile
PEG-2 (1440 x 1080 / CBR - 25000 -3276% |
Tokal saving bime:
Timeline segment layout:
O  Original
B Segmenifs] to be re-encoded
() Customized converted result fle size
Video Settings Audio Seltings
Frame Typa: Upper Fisld First Audio Format: MPEG audic
File Format: MPEG-2 Audio Type: Stereo
Frame Size: 1440 x 1080 Audio Channels: Stereo
Data Rate CBR - 25000 kbps Audio Frequency: 48000 Hz
Frame Rate: 29.97 frames / sec. Audio Bit Rate: 384 kbps
Display aspect ratioc 16:9

| Accept || Cancel || Hidedetal

Users can choose from several encoding settings.

To use the MPEG Optimizer

1 In VideoStudio, open or create a project that you want to save as an
MPEG.

2 In the Share panel, click & Create Video File, and choose MPEG
Optimizer from the menu.

3 In the MPEG Optimizer dialog box, click Show Detail, and review
the information specified, particularly the Optimal project settings
profile.

4 Click Accept.

New! Size setting in MPEG Optimizer: The new size setting in the MPEG
Optimizer lets users select a target size before encoding MPEGs. This feature is
especially helpful to users who share their videos on Web sites that set limits on
file size. In addition, when burning MPEGs to DVD, users can easily adjust the
size setting to ensure that their files will fit on the DVD.
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New! Corel® DVD Copy® 6 Plus: This hassle-free tool makes it easy to copy
and convert virtually any disc or video*. DVD Copy also includes support for
converting video for the Web or for mobile devices. In addition, DVD Copy
supports both AVCHD and DivX HD formats.

COREL DVD Copy

| i - S

DVD Copy lets users convert files for mobile devices, such as Apple iPhone.

To convert a video file for a mobile device

1 Start Corel DVD Copy 6 Plus, and click Convert File = .
2 Click the iPhone [ icon, and click the Add video from local drive

button.

3 Inthe Add Video Files dialog box, browse to the folder containing
the video file you want to convert, select the file, and then click Open.

4 In the Target area, click the Browse button to select a folder for
the converted file.

The default folder is C:\Documents and Settings\User Name\My
Document\My Videos.

5 In the Profile area, choose a quality setting from the menu.

6 Click Start Copying .

* DVD Copy 6 Plus does not copy encrypted or copy-protected materials.
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Summary of New and Enhanced Features

The following is a list of the new and enhanced features offered by
Corel VideoStudio™ Pro X2 Ultimate.

The Ultimate Solution for HD Video Production

Import directly from Blu-ray camcorders with new support for BDMV files.

Work with HD content smoothly and easily by using the enhanced Smart
Proxy editing.

Author Blu-ray and AVCHD discs with sophisticated menus.

Play back Blu-ray and AVCHD movies with WinDVD® 9 Plus Blu-ray — the
world’s #1 DVD and Blu-ray playback software.

Professional, Easy-To-Use Editing Tools

Create sophisticated effects with the new transitions in overlay tracks.

Overlap video clips to create a video transition and audio crossfade
automatically.

Easily adjust any of the panels within the new, resizable interface.

Take advantage of new, larger dialog boxes and controls to apply
effects and keyframes with greater accuracy.

Instantly preview filter effects with the new Filter View icons.

Display new autoplay previews for transitions, filters, and title
animations with a single click.

Switch to the new Timeline View to see all tracks in a project.

Adjust the enhanced Storyboard View, and drag to add clips or apply
filters.

Get real-time feedback on clip duration with the new timecode tip.

Automatically highlight faces in photo slide shows by using the new Auto
Pan & Zoom feature in VideoStudio Editor.

Trim single clips accurately and easily by using the new Single Clip Trim
dialog box.
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Discover features faster with the new updated icons.
Double-click the selected video filter or effect for an instant preview.
Add a new title track to run through an entire video.

Experiment with the 10 new animation presets for titles.

Add personal flair to videos with enhanced color backgrounds for titles.

Edit audio and improve sound quality with powerful mastering software
Steinberg® WavelLab™ LE 6.

Unique Special Effects

Record drawing, painting, or writing strokes as an animation to overlay on
video with the unique, new Painting Creator.

Apply NewBlue® Film Effects to give videos an “old-film"” appearance.

Create video magic by superimposing objects onto any background with the
enhanced Chroma Key effect.

Sample the new, professionally designed templates that match the
quality of any HD video.

Choose from an extensive library of new creative content, which includes
overlay objects, frames, Flash animations, and menu templates.

Any Output, Anywhere

Enjoy faster response times and rendering with new support for Intel®
quad-core technology for both dual-core and quad-core CPUs.

Enjoy faster rendering times by disabling the preview window.
Take advantage of faster encoding performance for MPEG-2 files.

Ensure that MPEG files meet size limits for online sharing, and fit on DVD, by
using the new Size Setting in the MPEG Optimizer.

Upload directly to YouTube with the new, streamlined uploader.

Copy DVDs and convert video files for easy sharing with
Corel® DVD Copy™ 6 Plus.
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About Corel Corporation

Corel Corporation is one of the world’s top software companies with more than 100 million active users
in over 75 countries. We develop software that helps people express their ideas and share their stories in
more exciting, creative, and persuasive ways. Through the years, we've built a reputation for delivering
innovative, trusted products that are easy to learn and use, helping people achieve new levels of
productivity. The industry has responded with hundreds of awards for software innovation, design, and
value.

Our award-winning product portfolio includes some of the world's most widely recognized and popular
software brands, including CoreIDRAW® Graphics Suite, Corel® Paint Shop Pro® Photo, Corel® Painter™,
VideoStudio®, WinDVD®, Corel® WordPerfect® Office, and WinZip®. Our global headquarters are in
Ottawa, Canada, with major offices in the United States, United Kingdom, Germany, China, Taiwan, and
Japan.
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